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        Users trust to manage documents on pdfFiller platform

        
                                                
                        65.5K+

                        documents added daily

                    

                                    
                        53%

                        of documents created 
from templates
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                        PDFs edited per month
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                        documents shared 
per month

                    

                                    

    


            
        
            
                
                                            
                            Underline In PDF Feature
                        

                                        
                        
                            
                            
                            
                            
                            
                            
                        
                    


                                                                        Our amazing Underline In PDF feature allows you to easily and efficiently underline text in your PDF documents.

                                                                                                Key Features

                                                                                                
                                                                    
                                        Seamlessly underline text in PDF documents

                                    

                                                                    
                                        Intuitive and user-friendly interface

                                    

                                                                    
                                        Customize underline color and thickness

                                    

                                                                    
                                        Save underlined PDF documents for easy access

                                    

                                                            

                                                                                                Potential Use Cases and Benefits

                                                                                                
                                                                    
                                        Highlight important information in contracts or legal documents

                                    

                                                                    
                                        Emphasize key points in research papers or academic articles

                                    

                                                                    
                                        Annotate and mark up documents for collaborative work

                                    

                                                                    
                                        Improve readability and organization of PDF files

                                    

                                                            

                                                                                                With our Underline In PDF feature, you can solve the problem of efficiently highlighting and emphasizing important information in your PDF documents. Say goodbye to manually underlining text with a pen or struggling with clunky editing tools. Our feature provides a seamless and intuitive way to underline text, allowing you to save time and effort. Whether you need to highlight critical details in contracts, annotate research papers, or collaborate on documents, our feature has got you covered. Experience the convenience and efficiency of underlining in PDFs with ease!

                                                            

            

        

    
            
    
        
            
                All-in-one PDF software
            

            
                A single pill for all your PDF headaches. Edit, fill out, eSign, and share – on any device.
            

            
                                    
                        Start free trial
                    
                            

            

            

        

    


                                
            
                    
        Instructions and Help about Remove Underline From PDF Online
    


             Did you ever need to underline or cross out text in PDF documents?

                

                In the past, you probably had to print the document, underline words or phrases with a pen, and either scan the document or send a hard copy to wherever it needed to go. Besides needing a printer and a scanner, the process probably took you far too much time to complete.

                Now there is a far easier way to underline text in PDF documents. You can simply use pdfFiller!

                 To get started, upload a document to your account and open it in the editor. To draw a line, click the Line icon in the main toolbar. The line toolbar will appear under the editing tools. Click where you want to create the start point and drag to where you want to create the end point, release the mouse button and click OK.

                

                 To change the line’s color, click on the black square and choose the color you want. Use the slider before or after drawing a line to change its thickness. You can change the position of the line ends by dragging them. Finally, you can always delete any line you've drawn, just select it and click the trash can icon that will appear.

                

                 To learn more about drawing lines in PDF documents online, please watch the following video:

                
            
                

                            

        

                When you use pdfFiller to underline text in PDF documents, you do not use paper, pencils, fax, and printer.  And even better, you save yourself a lot of time! If you like being able to underline text in PDF documents online, you might be interested in a lot of other great features that pdfFiller has to offer including highlighting and erasing content, adding pictures, text boxes and sticky notes, and creating fillable fields. Check out these tutorials to see the other great things that pdfFiller can do for you!
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                        To underline content in a PDF, upload your PDF document using pdfFiller's uploader.
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                        Choose the 'Line' button in the 'Tools' tab and draw a line. You can drag and move the line anywhere in your document. 
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                        You can also click the 'Tools' tab and highlight, redact or erase text and images in your PDF.
                    

                            

                        
                                    04

                    
                        When you're done with editing, click the 'Done' button and email, print or save your document.
                    

                            

                    

                

        
                
    
        
            
                
                    Related features
                

                
                                            
                            Bold Quote in the Studio Rental Agreement with ease
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                            Bold Quote in the Pet Adoption Contract with ease
                        

                                    

            

            
                
                    
                        
                        
                        
                        
                        
                        
                        
                    
                

            

        

    

            
        
                
        How to Use the Underline In PDF Feature
    


            The Underline In PDF feature in pdfFiller allows you to easily underline text in your PDF documents. Follow these simple steps to use this feature:

                
                        
                                    01

                    
                        Open the PDF document you want to edit in pdfFiller.
                    

                            

                        
                                    02

                    
                        Click on the 'Text' button in the toolbar at the top of the page.
                    

                            

                        
                                    03

                    
                        Select the text you want to underline by clicking and dragging your cursor over it.
                    

                            

                        
                                    04

                    
                        Once the text is selected, a formatting toolbar will appear above it.
                    

                            

                        
                                    05

                    
                        Click on the 'Underline' button in the formatting toolbar.
                    

                            

                        
                                    06

                    
                        The selected text will now be underlined.
                    

                            

                        
                                    07

                    
                        To remove the underline, simply click on the 'Underline' button again.
                    

                            

                    

                That's it! You have successfully used the Underline In PDF feature in pdfFiller. Enjoy editing your PDF documents with ease!

            

    
        
        
            
                 In order to get started, here are the steps we suggest:

Download the guide

You can download the guide or read the PDF. In-browser view — A HTML, JavaScript, and CSS file that opens in the browser. We recommend reading the PDF files, so you'll have a better understanding of how the tool works. Note: If you are signing up for an account using a non-Google account, you will need to create a Google account. When you install or start the online tools, you choose from a variety of options.. Online document management


In summary, we have designed the web version of the software to help you manage your documents. Documents can be saved in a range of formats including PDF, XLS, XLSX, HTML, HTML5, TXT, DOCX, DOC, ODT, CHM, MOB, and more. Save, edit, and share your documents easily


Create, edit and save documents using various document management tools such as Microsoft Word, Google Docs and Microsoft Excel. Save specific files to different folders, including subfolders within the file-based documents, such as project, workbook, presentation, presentations, and more. Online document management


Save and edit your documents using a variety of formatting tools, including a powerful template system. Create folders based on keyword, title or date. Add folders to save documents.. And finally, create and edit PDF documents with a single browser. Get the PDF form template you want, and all the PDF forms required to fulfill all those requests you've been getting for years. We support PDF annotations, so you can use your preferred word processor to fill the forms out, annotate them, or just create notes about your tasks. Create a PDF form using our powerful PDF editor, and then take care of the work with drag-and-drop file sharing, powerful search, and more. You'll always have an easy way to view, sign, and store your digital forms in your office, and you just need to write the instructions. The PDF forms editor is also compatible with third-party applications, which makes collaborating with them a snap. As you write a quick memo or report, you always keep things organized in your files. With PDF forms, you can now collaborate on paper documents by annotating them, saving signatures, or adding more information..
            

        

    
                
    
        What our customers say about pdfFiller

        See for yourself by reading reviews on the most popular resources:

        
            
                
                    
                        
                    

                    
                        
                            
                                    
                                
                            

                            4,5

                        

                        648 Reviews

                    

                
            

            
                    
                        
                    

                    
                        
                            
                                    
                                
                            

                            4,6

                        

                        661 Reviews

                    

                

            
                    
                        
                    

                    
                        
                            
                                    
                                
                            

                            4,4

                        

                        95k Reviews

                    

                

            
                    
                        
                    

                    
                        
                            
                                    
                                
                            

                            4,6

                        

                        9k Reviews

                    

                

        

                    
                                    
                        
                            
                                
                                    Consultant in Information Services

                                    

                                

                                
                                    2019-02-26

                                

                            

                            
                                
                                    What do you like best?

the ability to interface with the web to look for forms

What do you dislike?

the inability to pull the saved document back

Recommendations to others considering the product:

make it easier/possible to upload a previously saved form

What problems are you solving with the product?  What benefits have you realized?

not having to use a typewriter to fill out government forms.
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                                    Greg M.

                                    

                                

                                
                                    2017-11-14

                                

                            

                            
                                
                                    I think that it's a great thing. It makes fighting a case much easier. 
That more people don't use it. There is nothing else that I like least about it. My vice president used it also an has no problems with it.
Being able to find what your looking for, then being able to fill form in an save it, then come back to it.


                                    

                                

                            

                            
                                
                                    
                                

                                
                                    
                                                                                    

                                                                                    

                                                                                    

                                                                                    

                                                                                    

                                                                            

                                    5

                                

                            

                        

                    

                            

            

                
    
        
            
                
                    
                    Get a powerful PDF editor for your Mac or Windows PC

                    Install the desktop app to quickly edit PDFs, create fillable forms, and securely store your documents in the cloud.

                    
                        Download pdfFiller for Mac OS

                        Download pdfFiller for Windows PC

                    

                

            

            
                
                    
                    Edit and manage PDFs from anywhere using your iOS or Android device

                    Install our mobile app and edit PDFs using an award-winning toolkit wherever you go.

                    
                        Download from App Store

                        Download from Google Play

                    

                

            

            
                
                    
                    Get a PDF editor in your Google Chrome browser

                    Install the pdfFiller extension for Google Chrome to fill out and edit PDFs straight from search results.

                    Download from Chrome Web Store

                

            

        

    


        
    
        
            
                
                    pdfFiller scores top ratings in multiple categories on G2
                

            

            
                
                    

                    

                    

                    

                    

                    

                    

                    

                

            

        

    


                        
        
            
                                    For pdfFiller’s FAQs
                            

            
                                    Below is a list of the most common customer questions. If you can’t find an answer to your question, please don’t hesitate to reach out to us.
                            

            
                                    
                        
                            
Video: Annotate Document Using pdfFiller
                        

                                                    
                                                                    
                                        
                                            

                                                                                            Video: Annotate Document Using pdfFiller 
                                                                                    

                                    

                                                            

                                            

                                    
                        
                            
Video: How to black out and Redact Content Using pdfFiller
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Video: How to Underline PDF Documents Online Using pdfFiller
                        

                                                    
                                                                    
                                        
                                            

                                                                                            Video: How to Underline PDF Documents Online Using pdfFiller 
                                                                                    

                                    

                                                            

                                            

                                    
                        
                            
Video: How to Use Sticky Notes in the pdfFiller Online Editor
                        

                                                    
                                                                    
                                        
                                            

                                                                                            Video: How to Use Sticky Notes in the pdfFiller Online Editor 
                                                                                    

                                    

                                                            

                                            

                                    
                        
                            
Video: How to Erase & Whiteout Text in PDF Documents Online Using pdfFiller
                        

                                                    
                                                                    
                                        
                                            

                                                                                            Video: How to Erase & Whiteout Text in PDF Documents Online Using pdfFiller 
                                                                                    

                                    

                                                            

                                            

                                    
                        
                            
Video: How to Draw on a PDF Document Online Using pdfFiller
                        

                                                    
                                                                    
                                        
                                            

                                                                                            Video: How to Draw on a PDF Document Online Using pdfFiller 
                                                                                    

                                    

                                                            

                                            

                                    
                        
                            
Video: How to Highlight Content in a PDF Document Online Using pdfFiller
                        

                                                    
                                                                    
                                        
                                            

                                                                                            Video: How to Highlight Content in a PDF Document Online Using pdfFiller 
                                                                                    

                                    

                                                            

                                            

                                    
                        
                            
What is pdfFiller?
                        

                                                    pdfFiller is a web-based PDF editor. With pdfFiller, you can search for, edit, store and export PDF documents online without downloading and installing any software. pdfFiller also allows you to access and modify your PDF documents from any device anytime.

                                            

                                    
                        
                            
What browsers do pdfFiller.com support?
                        

                                                    pdfFiller.com supports Internet Exporter (IE), Google Chrome, and Mozilla Firefox.

                                            

                                    
                        
                            
Do I need to download or install any software?
                        

                                                    No downloads needed! pdfFiller.com is web-based application that does not need any additional software. pdfFiller.com supports any browser.

                                            

                                    
                        
                            
Can I edit a PDF document online?
                        

                                                    Yes. pdfFiller.com allows you to edit (modify, alter, correct, change, amend, revise, redact) any document with our various tools and features. You can rearrange, rotate, and delete, the pages. You can also, add text, images, and signatures to each page.

                                            

                                    
                        
                            
How to annotate PDFs?
                        

                                                    To annotate PDF documents, upload your document to pdfFiller, or choose the document your want to annotate in “My Forms” page and click “Fill” button. Open “Draw” tab and access the editor toolbar, you can have a variety of annotation features: highlight text, add comments, underline text and insert sticky notes or arrows.

                                            

                                    
                        
                            
How to underline in PDF?
                        

                                                    To underline in PDF documents, upload your PDF documents to pdfFiller, or choose the PDF you'd like to annotate in “My Forms” page and click “Fill” button on the right. You can find the “Line” button in “Tools” tab. Select the area or sentence you'd like to underline by clicking and holding the button on the mouse to draw a line around. Release the mouse when you're done. You can change the size of the line using the editor toolbar.

                                            

                                    
                        
                            
Can I underline into PDF?
                        

                                                    Yes, you can insert multiple lines into PDF documents using pdfFiller. To underline into PDF documents, upload your PDF documents to pdfFiller, or choose the PDF you'd like to annotate in “My Forms” page and click “Fill” button on the right. You can find the “Line” button in “Tools” tab. Select the area or sentence you'd like to underline by clicking and holding the button on the mouse to draw a line around. Release the mouse when you're done. You can change the size of the line using the editor toolbar.

                                            

                                    
                        
                            
How to underline text in PDF certificate form?
                        

                                                    To underline text in PDF forms, upload your PDF documents to pdfFiller, or choose the PDF you'd like to annotate in “My Forms” page and click “Fill” button on the right. You can find the “Line” button in “Tools” tab. Select the area or sentence you'd like to underline by clicking and holding the button on the mouse to draw a line around. Release the mouse when you're done. You can change the size of the line using the editor toolbar.

                                            

                                    
                        
                            
What PDF editor can draw a line to PDF forms?
                        

                                                    pdfFiller can help you draw a line to any PDF document online. To draw lines in PDF documents, upload your PDF documents to pdfFiller, or choose the PDF you'd like to annotate in “My Forms” page and click “Fill” button on the right. You can find the “Line” button in “Tools” tab. Select the area or sentence you'd like to draw lines by clicking and holding the button on the mouse to draw a line around. Release the mouse when you're done. You can change the size of the line using the editor toolbar.

                                            

                                    
                        
                            
How do I write on a document?
                        

                                                    To write on a document, click anywhere on the document and begin typing.

                                            

                                    
                        
                            
Can I type multiple lines when I have a lot of text?
                        

                                                    Yes. Just use “Enter” to create a line break. You can also paste large chunks of text and use Enter to restructure the lines.

                                            

                                    
                        
                            
How do I edit font settings?
                        

                                                    To edit font settings, begin by clicking on the “Font” button. You can then change the font type, adjust the size and color. Furthermore, you can also, modify text in to bold, underline, and italics.
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